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Important Notice 

This manual is subject to the following conditions and restrictions: 
 

This User’s Manual provides documentation for the PowerTerm WBT product. Your specific 
PowerTerm product might include only a portion of the features documented in this Manual. 

• 

• 

• 

• 

• 

• 

The proprietary information belonging to Ericom® Software is supplied solely for the 
purpose of assisting explicitly and properly authorized users of PowerTerm®. 
No part of its contents may be used for any other purpose, disclosed to any person or firm, or 
reproduced by any means, electronic and mechanical, without the express prior written 
permission of Ericom® Software. 
The text and graphics are for the purpose of illustration and reference only. The specifications 
on which they are based are subject to change without notice. 
The software describe in this document is furnished under a license agreement. The software 
may be used or copied only in accordance with the terms of that agreement. 
Information in this document is subject to change without notice. Corporate and individual 
names and data used in examples herein are fictitious unless otherwise noted. 

 
Copyright© 2000 - 2005 Ericom® Software 
 
Ericom® and PowerTerm® are registered trademarks of Ericom® Software, which may be 
registered in certain jurisdictions. Other company and brand, product and service names are 
trademarks or registered trademarks of their respective holders. 
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About this Manual 

This manual assumes that you are familiar with basic windowing system conventions and the 
operation of the terminal you intend to emulate. 
 
The PowerTerm WBT User’s Manual will present a typical PowerTerm WBT workflow. It will 
describe the basic steps of how to access remote terminals and start a session with stored 
parameters, as well as different options for ending a session. The Terminal Emulation property 
pages, the Power Script Language (PSL), and the Soft Input Panel will also be described. 
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Chapter 

Introduction to PowerTerm WBT 

This chapter presents PowerTerm WBT and its main features. It also describes the basic steps on 
how to use PowerTerm WBT for users who are familiar with accessing remote terminals. 
 
This chapter includes the following topics: 
 
What is PowerTerm WBT?
PowerTerm WBT Features
PowerTerm WBT Setup
A Quick Guide Through PowerTerm WBT  
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What is PowerTerm WBT? 

PowerTerm WBT is a fully functional terminal emulator for Microsoft Windows-Based Terminal. 
It emulates various terminal types, including IBM, UNIX, HP, VMS, and Tandem. PowerTerm 
WBT enables you to connect to a single or to multiple hosts via both network and serial or 
modem connections. PowerTerm WBT’s Session Manager provides quick access to a list of user-
configured sessions. PowerTerm WBT enables you to connect to a single or to multiple 
hosts via both network and serial or modem connections 
 
PowerTerm WBT has two main features to enable the WBT to act and feel like a real host 
terminal: 
 

Terminal display emulation • 

• 

• 

• 

• 

PowerTerm WBT emulates the exact display of the chosen terminal. It presents host 
applications precisely as they would appear on the terminal. Once the WBT connects to a 
host computer, all host operations can be performed as if the WBT is an actual host terminal. 
Terminal keyboard emulation 
PowerTerm WBT enables you to emulate the selected terminal’s keyboard by mapping the 
WBT keys to match the host keys. Keyboard mapping definitions are stored in the registry. 

 
PowerTerm WBT also provides various options to customize and optimize the working 
environment such as: 
 

Power Pad  
A programmable floating keypad. 
Soft buttons  
Programmable buttons located at the bottom of the PowerTerm WBT window. 
Power Script Language (PSL) 
A full-featured programming language, which enables you to create scripts for automating 
tasks. For example, you can create a PSL script for automatic login. Scripts can be used at 
startup of PowerTerm WBT, or can be utilized any time during a PowerTerm WBT session. 
PSL commands can also be assigned to the Soft buttons and/or the Power Pad to enable 
additional functions with a click. 
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PowerTerm WBT Features  

PowerTerm WBT features include: 
 

• Compact, light and high performance program 
• Supports TCP/IP WinSock 
• Supports RS-232 
• Power Script Language (PSL) 
• Session Manager 
• Macro recorder for automation of tasks 
• Enables you to save parameters for all sessions 
• Language support for all Western European languages 
• User programmable buttons 
• Floating Power Pad with programmable buttons 
• Control of color selection and screen attributes 
• Easy to use keyboard mapping 
• SCS Printer emulation 
• Setup replication 
• Online help (only upon request) 
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PowerTerm WBT Setup 

To enable PC-host interaction, you need to define two sets of parameters:  
 

Terminal parameters  • 
• Communication parameters 
 
These are both saved in the registry.  
 
PowerTerm WBT provides the option to work with a single host or with multiple hosts. You can 
create different setup configurations for working with each host to enable each user a customized 
working environment. Each one is saved in the registry. 
 

Working with a Single Terminal Connection 

When you launch PowerTerm WBT from the Connection Manager, it automatically uses the 
parameters in the setup configuration that you choose. 

Working with Multiple Terminal Connections 

If you are working with different terminals with different emulations, you may need to use a 
different setup for each emulation. To create a specific setup, you first need to create a new 
session (with its communication parameters) using the PowerTerm WBT wizard within the 
Connection Manager. After this is accomplished, you launch this newly created session and 
define the terminal setup and save it. These setups will reside in the registry from where they will 
be loaded upon launching the session. 
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A Quick Guide Through PowerTerm 
WBT 

The following workflow provides a quick guide for using PowerTerm WBT: 

 
 
Each of the steps is explained on the pages that follow.  

Step 1: Create a Connection Entry 

To define connection parameters: 

N
Open th

OTE In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Add button.  

Select E

e Connection Manager and click Add. The New Connection dialog appears. 1 

2 

3 
4 
5 
6 
7 

  
ricom PowerTerm WBT - Terminal Emulator (or the name that was pre-

defined by the OEM). 
Click OK. The Connection Properties dialog appears. 
Supply the IP address or Host Name. 
Select the desired Terminal Type and ID. 
Type the Terminal Name, if necessary. 
Modify the Port # if necessary. 
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Select the desired Emulation Type. 8 
9 
10 

1 

2 
3 

• 

Type the Connection Name. This name automatically appears in the Setup Name field. 
Click OK. The new connection appears in the Connection Name list of the Connection 
Manager. 
 

NOTE The above-mentioned parameters are for Telnet only. For other 
communication protocols, different required parameters may exist. 
 

Step 2: Connect to Host 

You can either select to connect to the terminal session you have just defined or connect to a 
previously defined connection. 
 
To connect to host: 

Select the desired session and click Connect. 
Or, 
Double-click on the selected session. 
The connection is established. 
Select Terminal  | Setup. The Terminal Setup dialog is displayed. 
Define the terminal settings. 

Step 3: Work with a Host 

PowerTerm WBT also provides a printing option where you can define print 
parameters, and print the terminal screen or data transferred from the host 
application. 

Step 4: Exit PowerTerm WBT 

Exiting PowerTerm WBT while it is connected to a host will end the connection. 
PowerTerm WBT provides two options for determining its behavior when exiting: 

• Prompt with a confirmation message prior to disconnecting. If you respond "No", the 
connection will not be closed and the exit operation will be canceled. (Default)  

• Disconnect automatically without prompting. 
 
To exit PowerTerm WBT: 

Select File | Exit or press both <Alt> and <X>. The PowerTerm WBT window closes. 
If you have changed terminal settings, PowerTerm WBT displays a warning message asking 
if you want to update the terminal settings saved in the registry. The message will point to the 
name of the setup configuration currently loaded. Click OK to update the terminal settings, or 
No to cancel the latest changes and restore the default setup. 
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Chapter 

The PowerTerm WBT Work Area 

This chapter provides an overview of the PowerTerm WBT window and its components. The 
PowerTerm WBT window contains menu options that provide access to most PowerTerm 
functions. The most important feature of the PowerTerm WBT window is its work (client) area, 
which emulates a host terminal screen by displaying data entered on your terminal, and data 
received from the host.  
 
This chapter describes the following topics: 
 
The PowerTerm WBT Window 
The Menu Bar 
The PowerTerm WBT Toolbar 
Hot Keys 
Manipulating Desktop Components 
Selecting Text 
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The PowerTerm WBT Window 

 
 
The following is a list of the PowerTerm WBT window components as they appear from top to 
bottom. 
 
Menu Bar Contains dropdown menus, which enable the user to perform 

most PowerTerm WBT operations.  
Toolbar Contains buttons, which can be used as shortcuts to access 

frequently used menu commands.  
 

Work Area Displays the data entered on the device terminal or received 
from the host. During an emulation session, this work area 
emulates a terminal display. For IBM terminal types, the 
background of the work area is displayed in black. 

History Scroll Bar Enables you to scroll up and down through the PowerTerm 
WBT window to view previously displayed data.  
Default: displayed  
For non-IBM emulations only. 

Soft Buttons Area Contains a series of buttons displayed above the Status bar that 
you can program to execute specific script commands.  
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Status Bar Displays the emulation type, cursor position (row and column), 
text wrap and Caps lock status and license information. 

 
Beside the Work Area, you can configure all the other components to be displayed or hidden.  
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Menu Bar 

The PowerTerm WBT Menu bar displays the main PowerTerm WBT functions in dropdown 
menus. The following is a brief description of each PowerTerm WBT menu and the functions that 
it can perform. For a more detailed description of each menu option, see Chapter 6, “Menu 
Reference”. 
  
File Menu Provides options to create, save and restore a terminal setup file 

as well as to open a new instance of the PowerTerm WBT 
window.  
The File menu also enables you to save your keyboard and Soft 
buttons settings and open them at a later date. 

Edit Menu Provides options to select, clear, and reverse text in the 
PowerTerm WBT window as well as delete the contents of the 
history buffer.  
The Edit menu also provides standard windowing operating 
system commands (cut, copy and paste) that enable you to copy 
data to a file or to the Clipboard. 

Terminal Menu Provides options to define and reset connection parameters 
(terminal and communication), set the system to be online or 
offline, and freeze or unfreeze the screen.  
You can also select the fonts and languages (in versions that 
support it) to be displayed in the PowerTerm WBT window. 

Sessions Menu Enables access to other terminal emulation sessions. 
Options Menu The Options menu provides various alternatives to customize 

your screen. It enables you to choose the size of your Power 
Pad and how to map your keyboard mapping. It also allows you 
to hide or show the menu, buttons, and status bar.  

Script Menu Provides commands to create and run PSL scripts. 
Help Menu Provides options for accessing product and license management 

information for PowerTerm WBT. 
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PowerTerm WBT Toolbar  

The PowerTerm WBT Toolbar contains icons, which provide shortcuts to frequently used menu 
options. 
 
The following is a brief description of the icons in the PowerTerm WBT toolbar: 
 
Hold Screen/Release Hold 

 

For non-IBM emulations only. 
Suspends and resumes communication with the host. 
After you click the Hold Screen icon, it turns red. After 
you click the icon again, it changes back to green, and 
update of the PowerTerm WBT window resumes.  
Equivalent to Terminal | Hold Screen.  

Cut 

 

For 5250 emulations only. 
Cuts the selected text. 

Copy To Clipboard 

 

Copies the selected data displayed in the PowerTerm 
WBT work area to the Clipboard.  
Equivalent to Edit | Copy. 

Paste From Clipboard 

 

Pastes data from the Clipboard to the host application. 
Equivalent to Edit | Paste. 
 

Print 

 

Prints selected text from the history buffer or the entire 
contents of the work area. 
Equivalent to File | Print Screen. 

Start/Stop Auto Print 

 

For non-IBM emulations only. 
Prints incoming data as it is displayed on the screen. 
Click the icon again and the automatic printing stops. 
Equivalent to File | Start Auto Print.  

Start/Stop Script Recording 

 

Records manual operations in script form. Click the icon 
again and the script recording stops. 
Equivalent to Script | Start Script Recording.  

Change To 80 Columns 

 

For non-IBM emulations only. 
Specifies an 80-column display for the PowerTerm WBT 
work area.  
Equivalent to Terminal | Setup | Display. 

Change To 132 Columns 

 

For non-IBM emulations only. 
Specifies a 132-column display for the PowerTerm WBT 
work area.  
Equivalent to Terminal | Setup | Display. 

Terminal Setup 

 

Displays the Terminal Setup dialog in which you can 
define terminal setup parameters. 
Equivalent to Terminal | Setup. 

Keyboard Mapping Opens the Keyboard Mapping dialog in which you can 
map PC keys to host keys.  
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Equivalent to Options | Keyboard Map. 
 

Show/Hide Power Pad 

 

Displays the Power Pad. Click the icon again and the 
Power Pad dialog closes. 
Equivalent to Options | Show Power Pad.  

Help Contents 

 

Displays product information. 
Equivalent to Help | Contents. 
(Only upon Request: Displays the PowerTerm WBT 
online help.) 

Session Manager 

 

Provides quick access to a list of user-configured 
sessions. 

Session 

 

Displays an icon with an identifiable letter for each 
additional session of PowerTerm WBT. 
Equivalent to pressing <Ctrl>+<Shift>+the desired 
session’s letter. 

 

To display a description of each icon: 

Place the cursor over the icon to display its description as a tooltip. • 
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Hot Keys 

Hot keys are keyboard shortcuts that you can use instead of choosing menu commands. These hot 
keys refer to your standard PC keyboard keys, before they are mapped to terminal keys. Once hot 
keys are mapped, they lose their original function and reflect the newly mapped terminal key. For 
example, if you map <Alt F4> to the <Backspace> key on the terminal keyboard, it performs the 
function of a <Backspace> key. 
 
The following table lists the default PowerTerm WBT hot keys:  
 
Alt F4 Exit. 
Alt F9 Activate script. 
Ctrl+Shift+R Start/stop script recording. 
Ctrl+Shift+P Activate recorded script. 
Alt F10 Select screen. 
Alt F11 Clear screen. 
Alt F12 Reverse screen. 5250 emulations not included. 
Scroll Lock Hold screen. 
Pause Change the cursor shape. 
Ctrl Up Arrow Scroll up one line. 
Ctrl Down Arrow Scroll down one line. 
Ctrl Home Scroll to the beginning of the history buffer. 
Ctrl End Scroll to the end of the history buffer. 
Ctrl Page Up Scroll up one page. 
Ctrl Page Down Scroll down one page. 
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Manipulating Desktop Components 

PowerTerm WBT enables you to customize the PowerTerm WBT window by displaying or 
hiding desktop components and changing the display colors for different text attributes. The color 
attributes change according to the emulation type you have selected. 
 
Most components are displayed or hidden according to your selection in the Options menu. An 
alternative is to use a floating menu with all the options. 
 
To open the floating menu: 

Press <Ctrl> + <Shift> + M and select the desired action. • 

• 
• 

• 

• 
• 

• 
• 

• 
• 

1 
2 
3 
4 

• 

• 

 
To show/hide the Menu bar: 

Select Options | Hide Menu. This conceals the Menu bar. 
Press <Ctrl>+<Shift> + M, and select Restore Menu. The Menu bar is shown again. 
Or, 
Map a Soft button with the following PSL command: 
menu restore. 

 
To show/hide the Soft buttons: 

Select Options | Hide Buttons. The menu option becomes Show Buttons. 
Select again to redisplay the Soft buttons bar. 

 
To show/hide the Status bar: 

Select Options | Hide Status Bar. The menu option becomes Show Status Bar. 
Select again to redisplay the Status bar. 

 
To show/hide the Power Pad: 

Select Options | Show Power Pad. The menu option becomes Hide Power Pad.  
Select again to hide the Power Pad. 

 
To show/hide the History Scroll bar: 

(For non-IBM emulations only.) 
Select Terminal | Setup. The Terminal Setup dialog appears. 
Click the Display tab. The Display Property page is displayed. 
Select History Scroll Bar in the General section. 
Click OK. The PowerTerm WBT window is redisplayed with the history scroll bar. 

 
Clear History Scroll Bar to remove the history scroll bar from the PowerTerm WBT 
window. 
 

To change the display color of the PowerTerm WBT window: 
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The color for the Normal attribute determines the color of the entire work area. The box above 
the Select Attribute parameter shows the result of your selections. The Select Attribute of the 
entire screen is generally Normal, for non-IBM emulations.  

Select Terminal | Setup. The Terminal Setup dialog is displayed. 1 
2 
3 

4 

5 

6 

1 
2 
3 

1 
2 
3 

Click the Colors tab. 
Select the attribute for which you want to define foreground and background colors. 
Notice that the attributes change according to the emulation type you selected previously. 
In the Text area, select the color that you want to apply to the text (foreground) of the 
display. 
In the Background area, select the color that you want to apply to the background of the 
text. The preview box above the Select Attribute parameter shows the result of your 
selections.  
Click OK to close the Terminal Setup dialog and display the PowerTerm WBT window 
in the selected colors. 

 
To disable/enable underline: 

 If data is transmitted with the Underline attribute, you can disable the underline by clearing this 
parameter.  

Select Terminal | Setup. The Terminal Setup dialog appears. 
Click the Colors tab. 
Select/Clear Enable Underline as desired. 

 
To disable/enable blink: 

You can choose whether to enable blinking of data, which was received from the host with the 
blinking attribute. 

Select Terminal | Setup. The Terminal Setup dialog appears. 
Click the Colors tab. The Colors Property page is displayed. 
Select/Clear Enable Blink as desired. 
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Selecting Text 

The following are descriptions of specific text selection techniques that you may find useful in 
different emulations. 
 
To select a word: 

• In the work area, click a word to select it.  

N
 

OTE If the Automatic Copy option in the Edit menu is active (default), 
selecting text also copies the selection to the Clipboard. 
 

To select a block: 

A block is any rectangular section of the work area. 
For VT emulations 

Point to one corner of the block, hold down the <Ctrl> key and drag the mouse 
to the opposite corner of the block you want to include in the selection. 

• 

• 

• 

• 

• 

• 

• 

For IBM 3270 and 5250 emulations 
Point to one corner of the block and drag the mouse to the opposite corner of the block you 
want to include in the selection. 

 
To select full lines: 

Point to a line, hold down the <Shift> key and drag the mouse to the last line you want to 
include in the selection. 

 
To select a string: 

Point to the first character that you want to include in the selection. Drag the 
mouse to the last character that you want to include in the selection and release 
the mouse button. 

 
To select the entire screen: 

Select Edit | Select Screen.  
 
To select a menu entry: 

For VT emulations 
Double-clicking on a word send that word to the host once you have pressed the 
<Enter> button. Use this feature to select a menu entry. For example, if the 
emulation screen displays the menu of an application residing on the host, click a 
menu entry to activate the program that the menu entry represents. 

 
To activate light pen support: 

For IBM 3270 emulations 
Any double-click on the screen is equivalent to touching the screen with a light pen. 
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Chapter 

Using PowerTerm WBT  

This chapter provides step-by-step instructions for using PowerTerm WBT and provides a 
detailed explanation of each step. You might need to alter the steps a little to fit the different 
OEMs, which have slightly different user interfaces. 
 

NOTE If you are familiar with terminal emulations, you may want to follow the 
procedure outlined in A Quick Guide Through PowerTerm WBT 
 

This chapter consists of the following topics: 
 
Step 1: Creating a Connection Entry 
Step 2: Setting Up Your Working Environment 
Step 3: Defining Settings for a Terminal Emulation 
Step 4: Saving the Terminal Setup 
Step 5: Working with the Host 
Step 6: Ending a PowerTerm WBT Session 
Step 7: Exiting PowerTerm WBT 
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Step 1: Creating a Connection Entry 

The connection parameters that you define will remain active only for the current session, unless 
you save them. 
 
To define connection parameters: 

NOTE The following is a description of Telnet communication protocol. Other 
communication protocols may require different parameters. 

 
 

N
Open th

OTE In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Add button.  

Select E

e Connection Manager and click Add. The New Connection dialog appears. 1 

2 

3 

4 
5 
6 
7 
8 
9 
10 
11 

 
ricom PowerTerm WBT - Terminal Emulator (or the name that was pre-

defined by the OEM) and click OK. The PowerTerm Connection Properties dialog 
appears. 
Select the desired Language for the user interface. 
Note: Modifying this field will cause loss to any previously entered information. 
Supply the IP address or Host Name. 
Select the desired emulation type from the different Terminals list. 
Select the Terminal ID. 
Type the Terminal name, if necessary. 
Modify the Port #, if necessary. 
Select the desired Session Type. 
Select the desired Security to be employed in the connection. 
Customize the Terminal Setup by clicking the Setup button. The property pages that 
will be displayed are determined according to the specified emulation type in the 
Connection Properties dialog.  
Type the Connection Name. This name will also automatically appear in the Use 
Terminal Configuration Setup field. However, you can change this setup if desired. 

12 

13 
14 

15 

Specify, if necessary, the Script Name be run on logon. 
Specify, if necessary, how many seconds to wait before connecting to host in the Wait 
Before Connect (Sec) field. 
Click OK. The new connection appears in the Connection Name list of the Connection 
Manager. 
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Connection Parameters 

 
 
Following is a description of the parameters that can be defined in the PowerTerm Connection 
Properties dialog. Some parameters change according to the emulation type selected. 
 
Session Type Session types differ according to emulation. For example, under 

a VT session you will see TELNET. The different types are 
described in detail on the following pages. For each session 
type, PowerTerm WBT displays a set of session parameters 
(some types have identical parameters). 

Host Name Specifies the host computer name or the host’s IP address. 
Terminal ID Enables you to change the ID returned by the emulation 

program to the host. 
Terminal Specifies the terminal name. 
Port # Specifies the port number. 
Emulation Type Enables you to change the currently supported emulation. 

Selecting terminal type 5250 Display enables you to assign a 
device name to a session. 

Device Name For AS/400 sessions. 
Enables you to enter the device name for the emulation session 
(maximum: 10 characters). 
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When using multiple sessions enter "devicename+". Each 
session will be automatically assigned a new name. For 
example, if the device name entered was John+, then the first 
session will be John1, the second John2 and so on.  

LU Name For 3270 emulations. 
In this parameter you can specify the name of the LU name 
(maximum: 8 characters). 

Language Specifies language for graphical user interface. 
Security Specifies whether or not to employ a security protocol.  
Use Terminal Configuration Specifies the terminal setup file to be used in the connection. 

You can browse for the file if necessary. 
Run Script On Logon Specifies the script to be run on logon. You can browse for the 

file if necessary. 
Connection Name Specifies the name of the connection, which is displayed both 

in the Connection Manager and Session Manager. 
Wait Before Connect (Sec) Specifies how many seconds to wait before connecting to host. 
About Displays PowerTerm WBT copyright and version number 

information. 

Session Types 

TELNET Uses the Telnet protocol over TCP/IP for network 
communication. For this session type, you must specify the 
host computer name or the IP address in the Host Name text 
box. You can also specify the TELNET port number (default 
23).  
The WINSOCK.DLL file must be in the search path. 

COM Uses serial communication with the PC's COM ports. For 
this type, you must define the baud rate, port number, parity, 
stop bits and flow control. Optionally, you can specify a 
phone (dial) number. 

TN3270 TELNET for 3270.  
Select Use TN3270E Protocol if you want to work with 
TELNET SNA extensions. You can also specify the LU 
name of the host (LU name or LU pool). 

TN5250 TELNET for 5250. 
 

To specify SSH Security parameters: 

Click Details in the PowerTerm Connection Properties dialog. The SSH Security 
dialog is displayed. 

1 

2 
3 
4 

Select the desired SSH Version. 
Fill out the necessary parameters. 
Click OK. The connection is now secure. 
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SSH Security Specifies whether to employ SSH in the host connection. 

• SSH Version, specifies which version of SSH is 
employed. 

• Show SSH Login Dialog on Connection, displays 
SSH Login dialog upon connection. 

• Show SSH info, displays the SSH information after the 
host connection is established. 

SSH properties: 
• User Name, specifies the User Name. 
• Cipher, specifies the cipher algorithm to be used to 

encrypt network traffic between the local machine and 
the server, thus providing data privacy. Available 
cipher algorithms are: BLOWFISH, 3DES, DES and 
AES. 

• Enable Compression, specifies to employ 
compression. 

• Enable x11 Forwarding, allows X Windows traffic 
between the X server and X client to be encrypted. 

• Attempt TIS or CryptoCard Authentication, 
attempts to authenticate with either TIS or CryptoCard. 

• Attempt ‘keyboard – interactive’ Auth (SSH2), 
attempts to authenticate with ‘keyboard – interactive’. 

• Allow Agent Forwarding, passes authorization 
information over the encrypted link. 

• Private Key File for Authentication, specifies the 

   
 



 
  

29

private key file for public key authentication. 
 
To use an existing configuration: 

Open the Connection Properties dialog and click  adjacent to the Setup field. The 
Open Terminal Setup dialog appears. 

1 

Choose the desired configuration from the Terminal Setups List and click OK. 2 

1 
2 
3 

4 
5 

1 
2 
3 

4 

5 

Modifying Connection Parameters 

This can be accessed from either within the Connection Manager or by right-clicking the desired 
connection in the Session Manager. 
 
To modify connection parameters: 

Exit PowerTerm WBT thereby rendering the current session inactive. 
Open the Connection Manager and select the desired connection. 

N
Click E

OTE In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Edit button. 

Modify

dit. The Connection Properties dialog appears. 

 
 the settings. 

Click OK. The modified settings are now in effect for the next emulation session. 

Customizing Settings 

The default setup name is the name of the connection. The capability of choosing the customized 
settings is dependent upon whether you saved the settings (see Save Terminal Setup As) with a 
name other than its current name when the PowerTerm WBT session is running. 
 
To customize settings:     

Exit PowerTerm WBT thereby rendering the current session inactive. 
Open the Connection Manager and select the desired connection 

N
Click E

OTE In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Edit button. 

dit. The Connection Properties dialog appears. 

 
Click the browse button in the Use Terminal Configuration section. The Open 
Terminal Setup dialog appears. 
Choose the desired setup either from the: 
Terminal Settings List or 
Host (see Importing a Terminal Setup) 
Click OK. The selected name appears in the Setup Name field. 6 

7 Click OK. The modified Connection Name now appears in the Connection Name list of 
the Configure tab. 
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Importing a Terminal Setup  

You can predefine terminal settings on your PC and then import them to PowerTerm WBT by 
using the FTP protocol. 
 

To import a terminal setup: 

Open the Connection Properties dialog and click  adjacent to the Setup field. The 
Open Terminal Setup dialog appears. 

1 

Click From Host. The Import Terminal Setup from Host dialog appears. 2 
3 
4 
5 
6 
7 

8 
9 
10 
11 

1 
2 

3 
4 

Type the necessary IP address of the FTP server in the Host Name field. 
Type in the appropriate User Name if necessary. 
Type in the appropriate Password if necessary. 
Type in the appropriate Setup Name if necessary. 
Click OK. A notification message about the file being transferred appears followed by a 
progress bar. The imported Setup Name then appears in the Terminal Setups List of the 
Open Terminal Setup dialog. 
Select the imported terminal setup and click OK.  
Fill out all of the necessary fields (Host Name, Connection Name etc.). 
Click OK.  

N
Select t

OTE In some PowerTerm WBT editions, you might have to select the 
Connection tab to be able to access the Connect button. 

he newly defined session and click Connect. 

 

Deleting a Connection 

To delete a connection:  

Exit PowerTerm WBT thereby rendering the current session inactive. 

N
Open th

OTE In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Delete button. 

e Connection Manager and select the desired connection. 

 
Click Delete. A confirmation notification is displayed. 
Click OK. The connection is deleted. 
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Step 2: Setting Up Your Working 
Environment 

This section provides a description of the basic operations that may be performed to set up and to 
optimize the PowerTerm WBT working environment for your usage. You can customize the 
PowerTerm WBT window to show or hide window components and change the window display. 
These options are all described in Chapter 2:  “The PowerTerm WBT Work Area, Manipulating 
Desktop Components”. 
 
You can also fine-tune the host application appearance on your screen by: 
 

Adjusting the display settings (number of columns and rows to be shown). • 
• Specifying a scaled or an unscaled screen. For more information see Step 3: “Defining 

Settings for a Terminal Emulation”, the Display Property page for non-IBM emulations and 
the General Property page for IBM 3270 and 5250 emulations. 
Selecting suitable fonts. • 

 
PowerTerm WBT enables you to emulate a host keyboard by assigning (mapping) host keys to 
the WBT device keys. You can save your keyboard settings in the registry with a unique name 
and open them at a later date. PowerTerm WBT also provides Soft buttons, which enable you to 
automate commands. 

N
 

OTE Any changes you make to the individual features (Keyboard Settings, Soft 
buttons or Power Pad) will not effect the others. For example any 
modifications in Soft buttons will not affect Keyboard settings or Power Pad. 

 
To set up the PowerTerm WBT work environment: 
 
Mapping the Keyboard 
Saving and Opening Keyboard Mapping Settings 
Programming the Power Pad 
Saving and Opening Power Pad Settings  
Programming Soft buttons 

Mapping the Keyboard 

PowerTerm WBT enables you to map WBT keys to host keys in order to emulate the host 
terminal keyboard. Keyboard mapping definitions are stored by default in the registry with the 
same name as the current terminal setup, however they can be modified.  
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To map a PC key: 

Select Options | Keyboard Map. The Keyboard Mapping dialog appears. 1 
2 

• 

1 
2 

3 

• 

• 

Drag a key from the upper terminal keyboard to a PC key on the lower keyboard. 
 

Click the <Shift> or <Control> keys on the terminal keyboard to display additional key 
functions. For example, if you click the <Shift> key, the alphabet keys on the terminal 
keyboard are displayed in upper case. You can then map (drag) these keys to your PC 
keyboard keys. 

 
To assign a script command to a PC key: 

Select Options | Keyboard Map. The Keyboard Mapping dialog appears. 
Right-click a key on the PC keyboard that you want to assign a command and select 
Enter Script Commands. The PC Button dialog appears. 
Enter the desired script commands and click OK. The PC key has now been assigned a 
script command. 

 
To map combinations of keys that include Alt, Ctrl, and Shift: 

Click the <Alt>, <Ctrl> or <Shift> key (or any combination) on your PC keyboard. Then 
map keys by following the procedure described previously. 
Click the required <Alt>, <Ctrl> or <Shift> key (or any combination of these keys) to view 
the mapped key. 

 
To cancel a keyboard key definition: 
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Drag the PC key definition that you want to cancel to the wastebasket icon, in the Keyboard 
Mapping dialog. This restores the default function of the PC key. 

• 

• 

• 

1 

2 

• 

1 

 
To replace a PC key with another PC key: 

PowerTerm WBT enables you to move the functionality of a mapped PC key to another PC key. 
For example, you can drag the F6 key on the PC keyboard to the spacebar on the PC keyboard to 
give it F6 functionality. 

Drag the desired PC key onto the PC key that it will replace in the Keyboard Mapping 
dialog. The functionality of the PC key has been replaced.  
Drag the original key back to its initial position. 

 
To copy a PC key to another PC key: 

PowerTerm WBT enables you to copy the function of one PC key to another PC key. 
 

Select the PC key whose function you want to copy to the required PC key and right-click 
Copy. 
Select the PC key to where you want to copy the function and right-click Paste. Both 
keys now have the same functionality. 

 
To restore the default keyboard mapping of all mapped keys: 

Click the Defaults button in the Keyboard Mapping dialog. 

Saving and Opening Keyboard Mapping Settings 

PowerTerm WBT enables you to save keyboard-mapping settings separately in the registry and 
open them at a later date. 
 
To load the keyboard mapping settings: 

Select File | Open Keyboard Setup. The Open Keyboard Setup dialog is displayed: 

 
Select the required keyboard settings from the list. 2 

3 Click OK. Parameters defined in the selected keyboard settings are now applied to the 
current session. 

 
To save keyboard mapping settings: 
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Select File | Save Keyboard Setup. The Save Keyboard Setup dialog appears: 

 

1 

Enter a Keyboard Setup Name like is shown above. 2 
3 

1 

Click OK. The keyboard mapping registry settings are saved with the specified setup 
name. 

Programming the Power Pad 

The Power Pad is a floating keypad that contains buttons, which can be programmed to execute 
customized PSL scripts. You can also change their names and adjust the number of buttons 
displayed in the Power Pad. You can display a maximum of 10 rows and 10 columns in the 
Power Pad. The default number of buttons is 9 rows and 4 columns. 
 
Power Pad buttons are named by default F1, F2, F3, and so on, with a few default function 
names, such as Clear, Enter, and Insert. For example, clicking on the F1 button is equivalent to 
sending F1 to the host. 
 
To program the Power Pad: 

Select Options | Show Power Pad or click  . The Power Pad is displayed. 
Right-click the Power Pad button that you want to program. The Power Pad Button 
dialog is displayed:  

 

2 

Enter Button Description (the new name that will appear on the Power Pad button) and 
click OK. The Power Pad Button dialog is displayed containing a field to enter a script 
command or script commands separated by semicolons. 

3 

4 Enter the Script Command to be run by this Power Pad button. For example, send 
<f13>, and click OK. Clicking on the Power Pad button will execute the newly defined 
script commands, for example, sending <F13> to the host. For more information, see 
Chapter 5: “Scripts”. 
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To adjust the number of buttons in the Power Pad: 

Select Options | Power Pad Setup. The Power Pad Setup dialog is displayed: 

 

1 

Click on the dropdown box to select the number of rows or columns that you want the 
Power Pad to contain. 

2 

3 

1 

Click OK. The Power Pad is displayed with the specified number of rows and columns. 

Saving and Opening Power Pad Settings 

PowerTerm WBT enables you to save your Power Pad settings in separate registry settings and 
open them at a later date. 
 
To save your Power Pad settings: 

Select File | Save Power Pad Setup. The Save Function Setup dialog is displayed: 

 
Enter a Power Pad Setup Name.  2 

3 Click OK. The Power Pad settings will be saved with the specified name. 
 
To open predefined Power Pad settings: 
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Select File | Open Power Pad Setup. The Open Function Setup dialog is displayed: 

 

1 

Select the required Power Pad setup. 2 
3 Click OK. Parameters defined in the selected Power Pad setup are now applied to the 

current session. 

Programming Soft Buttons 

 
Along the bottom of the PowerTerm WBT window are twelve programmable Soft buttons, by 
default named from F1 to F12. These can be renamed and programmed to execute customized 
scripts or to send individual commands to the host. Send the programmed command to the host 
by clicking the desired Soft button. Ffor example, clicking on the F1 Soft button is equivalent to 
sending F1 to the host. 
 
Soft buttons settings are saved together with the Power Pad settings. 
 
To program Soft buttons: 

Right-click on the Soft button that you want to program. The Function Button dialog is 
displayed: 

 

1 

Enter the function description (the new name that will appear on the button) and click 
OK. The Function Button dialog is displayed with a field to enter a script command, or 
script commands, separated by semicolons. 

2 

3 
4 

Enter the script command to be run by this button.  
Click OK. The Soft button is now displayed with its new name. Clicking on the Soft 
button will execute the newly defined script command. For more information, see 
Chapter 5: "Scripts, Using PowerTerm Scripts". 
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Step 3: Defining Settings for a 
Terminal Emulation (Terminal 
Settings) 

PowerTerm WBT enables you to define terminal settings for connecting to a host. Once you have 
defined the terminal settings, you can save them as a setup in the registry. This setup can be 
activated at a PowerTerm WBT startup. You can also create predefined Terminal settings on your 
PC and then copy them to your device. 
 
Each setting option is displayed in the format of a property page in the Terminal Setup dialog 
which can be accessed either from within the Connection Manager or by right-clicking the 
desired connection in the Session Manager.  

N
 

OTE The available settings are according to the selected emulation type.  
 
 

 
The terminal settings provided by PowerTerm WBT:  
 
General, defines parameters for the terminal emulation type. 
Display, defines display settings for the PowerTerm WBT window. 
Keyboard, defines keyboard setup parameters. 
Printer, defines printer parameters and advanced printing settings. 
Tabs, defines tab positions. 
Colors, defines color settings for the PowerTerm WBT window. 
Preferences, defines parameters that determine PowerTerm WBT behavior and automate 
processes. 

I
 

MPORTANT The parameters that you define will only remain active for the current 
session, unless you save them in the registry. For more information, see Step 4: 
“Saving the Terminal Setup”. 

General Property Page 

The General property page enables you to define parameters for the selected emulation type. 
 
To define emulation parameters: 

Select Terminal | Setup. The Terminal Setup dialog appears. 1 
2 
3 

Select the General tab. The General property page is displayed. 
Select the parameters that you require.  

The parameters displayed in the General property page are: 
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Terminal ID Determines the ID returned by the emulation program to the 

host. Verify that you select an ID that the host 
application/system recognizes. 

NRC Set Determines the communication and keyboard character set for 
7-bit data only. You can either select None or one of the 
languages available. 

UPS Set Determines the communication and keyboard character set for 
8-bit data only. Select one of the available character sets. 

8 bit Controls Enabled when UPS Set is specified as Code Page 437 and up. 
• 

• 

Disable, determines if 0x80 to 0xAF are displayed 
characters. 
Enable, determines if 0x80 to 0xAD are control characters. 

0x9B, all characters are displayed characters except 0x9B, 
which is a control character. 

Online Equivalent to Terminal | On Line (Off Line). 
New Line Determines whether the <Enter> key generates only a carriage 

return or a carriage return/line feed combination. 
Use 8 Bit Data Characters • 

• 

Select this parameter if the communicated data is in 8-bit 
character format. 
Clear it for 7-bit characters. When cleared, the 8th bit is 
truncated.  
If you receive 7-bit data, you can convert it to 8-bit data for 
printing on the slave printer. 

User Defined Keys (UDK)  Determines whether applications on the host system can 
override your user-defined keys (UDKs) when you have 
defined a function key that conflicts with how the host wants to 
use this key.  
• 
• 

Locked, prevents UDKs from being overridden.  
Unlocked, allows them to be overridden. 

Cursor Keys Determines whether the four arrow keys generate ANSI-
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standard (Normal) control sequences for moving the cursor, or 
generate customized Application program functions.  

Keypad  Determines the effects of the numeric keypad on your 
keyboard. 
• 

• 

• 

Numeric, keypad keys insert numbers. For example, 
pressing <7> on the numeric keypad is the same as typing 
'7' on the keyboard.  
Application, keypad keys generate control sequences that 
can be used by some applications. 
(Use) Numlock, Enables or disables the Numlock keyboard 
function in respect to the above Numeric and Application 
modes: 
"Numlock" checkbox not checked, The Numlock Key is 
a regular emulation key that has been mapped/defined as 
PF1 (default) or any other key. The Numlock Key will not 
change the Num Lock keyboard status. 
"Numlock" checkbox checked: 
Numeric Keypad Mode, The NumLock key toggles between 
function states: enabling numeric keys (when lit) or arrow 
keys (when not lit). 
Application Keypad Mode, The NumLock key toggles 
between function states: enabling numeric keys (when lit) 
or application keys (when not lit). Note: VT emulations 
only. 

Cursor coupling • 

• 

Vertical, determines whether the user window pans with 
the cursor when the cursor moves past the top or bottom 
border of the user window. 
Page, determines if a new page appears in the display when 
the cursor moves to a new page. 

Status Line For Wyse (ASCII) emulations. 
• 
• 

None, displays an emulation screen without the status line.  
Label Line, displays a status line on the top and bottom 
line of the emulation screen. 

Specific parameters for the 3270 and 5250 emulation types: 
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General • 

• 

• 

ID, determines the ID returned by the emulation program to 
the host. Make sure you select an ID that the host 
application recognizes.  
Unscaled Screen, When this parameter is cleared, the 
characters appearing in the work area are scaled. A change 
in the size of the desktop causes the fonts to shrink in 
relation to the size of the window. Select this parameter if 
you want to disable this feature. 
Show Response Time, displays the number of seconds that 
elapsed between the time data was sent to the host and the 
host response time. 

Cursor Ruler Select Visible to display full-screen, vertical or horizontal lines 
as a cursor ruler (cross hair guide). 
• 

• 

• 

Cross Hair, displays the cursor ruler as a horizontal and 
vertical line. 
Horizontal, displays the cursor ruler as a horizontal line 
only. 
Vertical, displays the cursor ruler as a vertical line only.. 

Cursor Controls the cursor appearance and functionality: 
• 

• 

Block/Underline/Visible/Blink, controls the cursor 
appearance. 
Ins Change, when selected it enables toggling the cursor 
between underline and block appearance, by clicking the 
Ins (insert) button. 

Appearance • 

• 

Power GUI, displays data in a window with 3D look & 
feel. Use system fonts larger than 10 pt. for optimized 
results. 
Show Frame, places a frame around the text area of the 
emulation. 

HLLAPI Names The names of an hllapi session can either be short or long. 
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Short and Long: 
Enables you to specify the short and long HLLAPI names. 

Code Page Specifies the host and PC (keyboard) character sets.  
Alternate Size • 

• 

Enable, select to override the terminal alternate size with a 
specific size. 
Rows/Columns type the required number. 

Display Property Page 

The Display property page enables you to define parameters that determine the appearance 
(display) of the PowerTerm WBT window. 
 

NOTE For non-IBM emulations only. 
 

 

To define display parameters: 

Select Terminal | Setup. The Terminal Setup dialog appears. 1 
2 
3 

Select the Display tab. The Display property page is displayed. 
Select the parameters that you require. 

The parameters displayed in the Display property page are: 
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General • 

• 

• 

• 

Reverse Display Colors, reverses the text and background 
colors in the work area.  
Unscaled Screen, When this parameter is cleared, the 
characters appearing in the work area are scaled. A change 
in the size of the desktop causes the fonts to shrink in 
relation to the size of the window. Select this parameter if 
you want to disable this feature.. 
Autowrap Characters, wraps words at the end of a line 
and the cursor moves to the next line. 
History Scroll Bar, displays the vertical history scroll bar 
along the right edge of the PowerTerm WBT screen. This 
enables you to scroll through the data displayed previously 
on the screen. If the host transmits during scrolling, the 
display automatically scrolls back to its current position. 
NOTE Selecting Clear History from the Edit menu 
can erase the History buffer. 

Cursor Ruler Select Visible to display full-screen, vertical or horizontal lines 
as a cursor ruler (cross hair guide). 
• 

• 

• 

Cross Hair, displays the cursor ruler as a horizontal and 
vertical line. 
Horizontal, displays the cursor ruler as a horizontal line 
only. 
Vertical, displays the cursor ruler as a vertical line only. 

Cursor Controls the cursor appearance and functionality. 
• 

• 

Block/Underline/Visible/Blink, controls the cursor 
appearance. 
Ins Change, when selected, it enables toggling the cursor 
between underline and block appearance by clicking the Ins 
(insert) button. 

Ctrl Characters Display, displays the control characters.  
Interpret, displays normal text as affected by control 
characters 

Power GUI Displays data in a window with 3D look & feel. Use System 
fonts larger than 10 pt. for optimized results. 

Show Frame Places a frame around the text area of the emulation. 
Dimensions Determines the number of characters (columns) per displayed 

line, and the number of lines to be displayed in the work area. 
Characters are scaled according to the selected values. 
Type a different value in the Other box instead of choosing one 
of the standard options (80 and 132). 

Scrolling Determines the pace at which data is displayed in the work area 
as it arrives. If you select Jump, you should determine the 
Jump Scroll Speed that is measured in number of line units. 
The higher the value, the faster the scrolling. 
• 
• 
• 

Unlimited, displays data without delaying communication. 
Page, scrolls data by full screens. 
Smooth, is equivalent to a Jump Scroll Speed of 1. 

Enable Soft Fonts Enables you to work with VT soft fonts. The fonts will be 
loaded from the host application. 
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Keyboard Property Page 

The Keyboard property page enables you to define keyboard parameters for your WBT. 
 
To define keyboard parameters: 

Select Terminal | Setup. The Terminal Setup dialog appears. 1 
2 
3 

Select the Keyboard tab. The Keyboard property page is displayed. 
Select the parameters that you require. 

The parameters displayed in the Keyboard property page are: 

 
 
Backspace Key Sends Determines whether the <Backspace> key sends Delete or an 

actual Backspace. 
Auto Repeat Repeatedly displays the character whose key is being 

continuously pressed down. 
Key Click Issues a click sound when you press a key on the keyboard. 
Warning Bell Determines whether the terminal sounds a bell tone when 

receiving the "bell" (ASCII 7) character. For operating errors, 
mail messages etc. 

Margin bell Determines whether the terminal sounds a bell tone when the 
cursor reaches the right margin. 

Numpad Decimal Sends 
Comma 

Specifies that the Numeric Pad's decimal key sends a comma 
instead of a decimal. 

Use Emulator Alt Keys Select to make an <Alt> key perform the terminal operation 
even if Windows OS has an operation mapped to the same key. 

Local Echo Determines whether keyboard input is displayed (echoed) on 
your screen. 
• 

• 

Select to display the keyboard input even if the host system 
does not echo your input.  
Clear to send the keyboard input to the host system without 
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being displayed on the screen (unless the host system 
echoes the characters). 

Use VT Keyboard Mode Changes your keyboard into a Digital VT keyboard mode. In 
this mode, the PC keyboard operates as close to a VT keyboard 
as possible, and takes full advantage of LK450 Digital 
keyboards. 

Answerback Message Specifies an answerback message and its display. 
• 
• 

Clear, deletes the message. 
Conceal, hides the message without being deleted. 

Auto Answerback Determines whether the terminal automatically sends the 
message to the host system after you make the connection. This 
is useful if your answerback message is a command to the host 
system. 

Specific parameters for IBM emulation types: 

 
 
Backspace Deletes Select to delete characters by pressing the Backspace key. 
Auto Repeat Repeatedly displays the character for which its key is being 

continuously pressed down. 
Key Click Issues a click sound when you press a key on the keyboard. 
Lock Numeric Field Determines whether the keyboard is locked when you try to 

enter non-numeric data. 
Typeahead Types data ahead, before the host responds. 
Automatic Reset Key  If the keyboard is locked, a reset key sequence is generated 

prior to when you click on the tab key to advance to the next 
field. 

Use Shift Lock Simulates Shift Lock. When this parameter is checked, the 
entire keyboard moves to Shift Lock status. For example, if you 
type “a”; the keyboard issues “A”. 

Numpad Decimal Sends Determines whether the Numeric Pad sends a comma instead 
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Comma of a decimal. 
Use Emulator ALT Keys Select to make an <Alt> key perform the terminal operation 

even if Windows OS has an operation mapped to the same key. 
Non SNA System Wait Only for 5250 emulations. 

Determines whether the System Wait in the IBM 3270 
emulation will act as a System Wait in a non-SNA terminal. 

Printer Property Page 

The Printer property page enables you to define printer parameters for your PC. 
 
To define printer parameters: 

Select Terminal | Setup. The Terminal Setup dialog appears. 1 
2 
3 

Select the Printer tab. The Printer property page appears. 
Select the parameters that you require.  

The parameters displayed in the Printer property page are: 
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Print Device Allows you to select a printing output channel:  
• 

• 

• 

None, no destination was assigned. The Device Name is 
disabled. Printer data is received by the terminal, but 
discarded (not printed). 
Device, sends printing to the device you designate in the 
Device Name text box. This can be a device such as 
COM1, COM 2 , COM3 etc. In the Device Name text box, 
you can also specify communication parameters. For 
example: COM 1:9600,8. 
Network, sends printing to the network printer. 
You must then perform the following: 
1. Select File | Print Setup. 
2. Select Network from Port field. 
3. Type UNC (Universal Naming Convention) in the Net      
Path, for example: \\ net1\hp4000 

Device Name The available printing devices are: 
• 
• 

LPT1: (default) 
COM x: 

Use Form Feed Adds a form feed (page eject) after each printing job. 
This depends upon the available connections on your PC/WBT. 

Print Line Graphics As Text Converts line graphics to text. This speeds up printing on a 
slow dot-matrix printer. 

CR->CRLF Adds a line feed after each single carriage return (one that has 
no line feed following it) when in slave printing mode. 

Print Screen Data 
Conversion 

Converts data to IBM or Digital character sets or prints in 
Graphics mode. 
• None, does not convert data. 

Slave Printer Data 
Conversion 

Converts data to IBM or Digital character sets, or prints in 
Graphics mode for slave printing. 
• None, does not convert data.  

Slave Printer Job Delimiter Specifies the job delimiter character that will divide the data 
into print jobs, thus disabling the escape sequences arriving 
from the host application. 
Non-IBM sessions only. 

Delay for Print Closing The command to close the printer queue is delayed by the 
number of seconds that you determine. This command only 
takes effect if no open command is issued in the meantime. 
Important for printing to cut sheet printers (for example, 
inkjets/lasers) and network printers. 

 
How to print to a Device: 
 
1 Select Terminal | Setup. The Terminal Setup dialog appears. 
2 Select the Printer tab, and from the Print Device dropdown list select Device. 
3 Enter your print communication port in the Device Name field and click OK.  

Note: Device Name in the Printer Properties page relates to a specific non-Windows 
utility to which to print. 
For example LPT1: in the event that your printer is connected to the LPT1 port. 

4 Select File | Save Terminal Settings.  
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5 Select File | Exit. 

Advanced Printing 

The Advanced Printer Setup dialog enables you to define additional printer parameters. 

 

Non 5250 printing 

There are two different modes with different fields enabled: 
Text mode is designated in the Printer property page by setting the two data conversion 
combo boxes (Print Screen and Slave Printer) to None. 

• 

• 

1 
2 
3 

4 

Graphics mode is graphic printing. 
 
To set values for non-host print transform in text mode: 

Select the Printer property page. 
Click the Advanced Printing button. The Advanced Printer Setup dialog appears. 
Select your printer model, or a compatible one, from the Printer/Type Model drop down 
list. 
Use the initial printer values that appear in the Font, CPI, LPI, Printer Columns and 
Printer Rows combo boxes or override them by clearing the Ignore check box and 
setting the desired values in the adjacent field. 
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Determine the paper orientation (Ignore, Portrait, Landscape). 5 
6 
7 

Configure the paper Tray for your printing. 
Click OK. 

The parameters displayed in Text mode are: 

Printer Type Specifies the destination printer. 
Edit enables you edit the printer configuration file.  

Ignore Disables the adjacent field. When selected, default values are 
applied. 

Font Printer default font and size will be applied to the output when 
Ignore is selected. Otherwise, User input will be applied. 
Select the desired font from the Font dropdown list. 

CPI Characters Per Inch 
LPI Lines Per Inch 
Printer Columns Determines the number of printer columns in the output.  

Select Ignore to apply the number of columns on your emulation
screen to the output. For graphic printing only. 

Printer Rows Determines the number of printer rows in the output.  
Select Ignore to apply the default values of the specific 
emulation to the output. For graphic printing only. 

Page Type For Text Printing Specifies the page type (i.e. A3, A4, A5 etc). 
Form Feed Defines the form type of the printer. PowerTerm provides the 

following three types: 
• 

• 

• 

AUTOCUT, single-cut sheets are automatically fed into the 
printer. Most printers require a sheet feed attachment. 
CONT, continuous sheets are used by printers that have a 
tractor feed attachment on the device. 
CUT, single-cut sheets are manually fed into the printer. 

Orientation Specifies the orientation of the printed output. The default 
depends on your printer’s settings. Options are: 
• 
• 
• 

Ignore 
Portrait 
Landscape 

Graphics mode parameters: 

Printer Columns and Printer Rows are the only relevant fields. • 
• 

1 
2 
3 

4 

Select the desired Orientation in the Print Setup dialog. 

TN5250 Printing Session 

To set values for non-host print transform in text mode: 

Select the Printer property page. 
Click the Advance Printing button. The Advanced Printer Setup dialog is displayed. 
Select your printer model, or a compatible one, from the Printer Type / Model drop 
down list.  
Use the host values for the Font, CPI, LPI, Printer Columns and Printer Rows or 
override them by clearing the Use Host Value check box and selecting the desired value 
from the adjacent fields. See the above explanations concerning these parameters. 
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Determine the paper orientation (Ignore, Portrait, Landscape). 5 
6 
7 

1 
2 

3 
4 
5 
6 

• 
• 

Configure the paper Tray for your printing. 
Click OK. 

 
 
To enable host print transform: 

NOTE For 5250 printer session only. 

 

 
 

Select Enable Host Print Transform. 
Select the manufacturer printer type and model from the Printer Type/Model dropdown 
list. 
Select the paper size from the Drawer 1 dropdown list. 
Select the paper size from the Drawer 2 dropdown list. 
Select the paper size from the Envelope Hopper dropdown list. 
Specify whether the printer has Code Page 899 installed in the Supports ASCII Code-
Page 899 check box. 

 
Additional settings for Other Printers: 

Specify the Customizing Object. 
Specify the Customizing Object’s Library. 

The parameters displayed in host print transform are: 

 
Enable AS/400 Host Print 
Transform 

Enabled, pass through (transparent) mode. The host sends 
(ASCII) command and text directly to the printer. Non-graphic 
printing only. 
Disabled, the host sends (EBCDIC) 5250 SCS format 
commands and text to the emulation. The emulation, in turn, 
translates to printer specific commands.  

Customizing Object Specifies the object name that you have previously defined on 
the AS/400. 
Enabled only for "Other" Printer model. 

Library Specifies the customizing object’s library on the AS/400. 
Enabled only for "Other" Printer model. 

Drawer 1 Specifies the size for the paper in Paper Source 1. 
Drawer 2 Specifies the size for the paper in Paper Source 2. 
Envelope Hopper Specifies the size of the envelope. 
Supports ASCII Code-Page 
899 

Specifies whether the printer has Code Page 899 installed. 

Defining the Printout Margins 

Printout margins are the space between the edge of the printout page and the border of the 
printing. Margins of the print output can be customized according to your specific needs. 
Modifying the top and left margins will determine the position at which printing will begin. 
 
To define the printout margins: 
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Open the Terminal Setup dialog and select the Printer property page. 1 
2 
3 
4 

5 
6 
7 

1 
2 
3 

Set the Data Conversion Type to Graphics. 
Click Advance Printing. 
Type the desired printout Margin(s), for example to shift the margin 1 cm in the desired 
direction, type in 100. 
Select Auto/Auto (Printer Sizes) for the CPI value to enable the right margin field. 
Select Auto/Auto (Printer Sizes) for the LPI value to enable the bottom margin field. 
Select Ignore for CPI/LPI values to use default printer values 

Tabs Properties Page 

The Tabs properties page enables you to determine tabs in the work area. Tabbed data received 
from the host will be laid out in the work area according to ruler settings defined with this option. 

N
 

OTE This option is only displayed for VT terminal types. 
 
 

To define tab parameters: 

Select Terminal | Setup. The Terminal Setup dialog is displayed. 
Select the Tabs tab. The Tabs properties page is displayed. 
Select the tab parameters that you require. 

The parameters displayed in the Tab property page are: 
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Tab Stops Click anywhere within the Tab Stops area to set tab stops 
manually. 
• 

• 

Set Every, sets a tab stop in increments of a number typed 
in the adjacent text field.  
Clear All, clears all tab stops. 

Colors Property Page 

The Colors property page enables you to define the color of data displayed in the work area.  
 
To define color parameters: 

Select Terminal | Setup. The Terminal Setup dialog appears. 1 
2 
3 

Select the Colors tab. The Colors property page is displayed. 
Select the parameters that you require. 

The parameters displayed in the Colors property page are: 

 
 
Preview Box Shows the result of your selections.  
Enable Underline Enables underlined characters.  

Clear to disable displaying data with the underline, for data 
transmitted from the host with the Underline attribute. 

Enable Blink Enables blinking. 
Clear to disable blinking data, for data transmitted from the host 
with the Blink attribute. 

Coloring method dropdown 
list 

For selecting the coloring method: 
• Default, Uses the default color type for each emulation 

type: 
VT and Siemens - Attribute & ANSI colors 
ANSI and HP - ANSI colors 
All others - Attribute colors (i.e not affected by setting 
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to a different value) 
• Attribute, Colors based on the attributes. For example, 

you can select different colors for bold, for underline, 
and for bold/underline. 

• ANSI, Colors based on host-defined colors. For 
example, the host sends "red foreground on blue 
background" however you can select the default ANSI 
color. Different attributes do not affect colors. 

• Attribute & ANSI, Uses both Attribute and ANSI 
colors as explained above. 

ANSI 8 color mode A regular terminal has 16 colors (8 colors with the Bold 
attribute applied to them and 8 colors without the Bold attribute 
applied to them). The Background color never has the bold 
attribute (therefore it is "dark") while the Text (foreground) is 
always mapped to the color with the Bold (bright, light) 
attribute. 

• Non-selected, Each entity (text, background) can have 
any of the 16 colors mapped to them. 

• Selected, Each entity (text, background) can have any 
of the 8 colors mapped to them.  

Color Frame Select to draw a color frame on the screen. 
Select Attribute Select the attribute for which you want to define foreground 

and background colors. Attributes change according to the 
emulation type you selected in the Connection properties 
dialog. Generally, the attribute of the entire screen is Normal. 
The color for the Normal attribute determines the color of the 
entire work area. 

Text Select the color that will apply to the text (foreground) of the 
display. 

Background Select the color that will apply to the background of the text. 

Specific parameter for IBM 5250 emulation type: 
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Preview Box Shows the result of your selections.  
Enable Underline Enables underlined characters.  

Clear to disable displaying data with the underline, for data 
transmitted from the host with the Underline attribute. 

Enable Blink Enables blinking. 
Clear to disable blinking data, for data transmitted from the host 
with the Blink attribute. 

Column Separator Displays a period as a column separator in fields with the 
column separator attribute. 

Color Frame Select to draw a color frame on the screen. 
Select Attribute Select the attribute for which you want to define foreground 

and background colors. Attributes change according to the 
emulation type you selected in the Connection properties 
dialog. Generally, the attribute of the entire screen is Normal. 
The color for the Normal attribute determines the color of the 
entire work area. 

Text Select the color that will apply to the text (foreground) of the 
display. 

Background Select the color that will apply to the background of the text. 

Preferences Property Page 

The Preferences property page enables you to determine PowerTerm WBT behavior and 
automate processes. These remain active until you change them. For example, if you select to 
connect automatically at PowerTerm WBT startup, you will always be connected when you open 
PowerTerm WBT, until you change this setting in the Preferences property page. 
 
To define PowerTerm WBT preferences: 

Select Terminal | Setup. The Terminal Setup dialog appears. 1 
2 Select the Preferences tab. The Preferences property page is displayed. 
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Select the parameters that you require. 3 

The parameters displayed in the Preferences property page are: 

 
 
History Buffer Specifies the size of the buffer in which data is stored, by 

selecting an option from the dropdown list. 
On PowerTerm Exit • 

• 

• 

• 

Save Terminal Setup, the new terminal parameters (if you 
changed them) are saved to the current terminal setup file. 
Confirm Save, terminal parameters are not saved 
automatically. PowerTerm WBT displays a dialog where 
you can decide whether or not to save.  
Confirm Disconnect Session, if you close PowerTerm 
WBT during a session, you will be requested to confirm 
disconnect. 
Inactivity Timeout, specifies the time limit for keyboard 
inactivity, after which time PowerTerm WBT shuts down. 

On Session Exit • 

• 

Auto Reconnect, re-establishes communication if the line 
was disconnected. 
Auto Exit PowerTerm, closes PowerTerm WBT 
altogether on disconnect. 
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Step 4: Saving the Terminal Setup 

Once both terminal and communication settings have been defined, you can save them in the 
registry. These settings can be used to start PowerTerm WBT, or can be modified manually 
during a PowerTerm WBT session. 
 
You have the option of saving the terminal setup with a name other than its current name by 
selecting Terminal Setup As. Otherwise the Save Terminal Setup option will save the current 
terminal settings under its present name in the registry, thus overwriting any previously defined 
parameters.  
 
To save terminal settings to the current setup configuration: 

• Select File | Save Terminal Setup. The current terminal settings are saved to the registry. 
 
To save a terminal setup under a different name: 

Select File | Save Terminal Setup As. The Save Terminal Setup dialog is displayed: 1 

 
Type in the desired Terminal Setup Name. 2 

3 Click OK. The terminal setup is saved in the registry with the new setup name. 
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Step 5: Working with the Host 
(Printing) 

Once you have connected to a host, PowerTerm WBT enables you to work as if you are working 
from a terminal. 
 
This section will mainly explain how to print data from your host application and other printing 
issues. 

LU/Device Name for IBM 3270/5250 
Emulations 

You can assign a LU/Device name when you enter the connection properties for your session. 
There are different options to assign a name: 
 

• Specific LU/Device Naming 
• Specific LU/Device Naming by Session ID 
• Pool LU/Device Naming 

 
These three different methods are explained below with examples. 
 
To assign a LU/device name to a 3270/5250 session: 

Open the Terminal Connection Manager. 1 
2 

3 
4 
5 

6 

7 

Select a 3270 or 5250 Display emulation and click Edit. The Connection Properties 
ppears. 

N
dialog a

OTE In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Edit button. 

Select y
 
our Session Type. 

Enter the name of the IBM host in Host Name. 

N
Specify

OTE Maximum length of the assigned Device name is 10 characters, 
while that of LU name is 8 characters. 

When u

 the device name for the emulation session in LU/Device Name. 

 
sing multiple sessions, enter "devicename+" and each session will be 

automatically assigned a new name. For example, if the device name entered was John+, 
then the first session will be John1, the second session John2, and so on. 
Click Connect. The IBM emulation session begins and is assigned a device name. 

Automatic name generation according to user’s rules: 

 
TN3270 LU Name and TN5250 Session Device Name Options 
Device 
Name 

   

Entered  Assigned Entered  Assigned 
DEV- Dev0 to Dev9 DEV-- Dev00 to Dev99 And so on … 
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DEV+ Dev1 to Dev9 DEV++ Dev01 to Dev99 And so on … 
Session Pool device name (3270 and 5250) 
DEV* Dev1 to Dev9 DEV** Dev01 to Dev99 And so on … 
DEV-3 Dev0 to Dev3 DEV-30 Dev00 to Dev30  And so on … 
DEV+3 or 
DEV*3 

Dev1to Dev3 DEV+30or 
DEV*30 

Dev01 to Dev30  And so on … 

 
The difference in behavior between specific LU/Device naming, specific LU/Device naming by 
Session ID and pool LU/device naming can be demonstrated in the following examples: 
 
Specific LU/Device Naming 
A specific name like SALES1 is entered. If it is not available, the connection attempt fails. 
 
Specific LU/Device Naming by Session ID 
DEV+ (a session ID) was entered as the device name when session E  (a local non-unique 
identifier) was opened. It will try to connect only as DEV5, and will fail if that LU/device name is 
not available since each session has its own unique name. 
DEV- (a session ID) was entered as the LU/device name when session E (a local non-unique 
identifier) was opened. It will try to connect only as DEV4, and will fail if that LU/device name is 
not available since each session has its own unique name. 
 
Pool LU/Device Naming 
DEV** was entered as the LU/device name when session E (or any other session) was opened. It 
will try to find an available LU/device name between DEV01 and DEV99, starting with DEV01, 
then DEV02, etc. Only if none of these LU/device names are available will it fail. 

Printing Data 

PowerTerm WBT enables you to define print parameters and print the terminal screen or data 
transferred from the host application. 
 
To print accumulated data displayed in the work area: 

Select File | Start Auto Print. The Start Auto Print command starts accumulating 
incoming data (while it is displayed on the screen). After you select this command, the 
menu option changes to Stop Printing.  

1 

2 Select File | Stop Printing. The Stop Printing command prints all the data accumulated 
in the printing buffer of the slave printer, or in the autoprint buffer. If data was buffered 
with a printing request and communication failed before the data was sent to the slave 
printer, select this command to print the accumulated information. 

 
To configure a printer session using device naming: 

(For IBM emulations only) 
1 Create a connection entry in Terminal Connection Manager 
2 Enter the name of the 3270/5250 (AS/400) host in the Host Name field.  
3 Enter the name of the device for the printer session, in the LU/Device Name field. 
4 Connect to a host in Terminal Connection Manager.  A gray emulation screen, which 

displays the slave printer data, appears.  
6 Leave it open. The host creates a queue based on the specified device name. 
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7 Open another pre-defined IBM display session using the Terminal Connection 
Manager, and send your print jobs to the queue created on the Mainframe / AS/400. 

 
To print the Terminal Screen: 

• Select File | Print Screen to print screens in the history buffer, or the entire contents of the 
work area. 

N
 

OTE In order to print selected text it must appear in the History buffer. 
 
 

To execute a form feed on the printer: 

• Select File | Form Feed. 
 
To execute a line feed on the printer: 

• Select File | Line Feed. 
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Step 6: Ending a PowerTerm WBT 
Session 

You need to end the session(s) before exiting the PowerTerm WBT application. PowerTerm 
WBT provides three options to end a session: 
 
Automatic Closing, PowerTerm WBT automatically closes when you close a session.  
Optional Closing, For non-IBM emulations. Enables you to reestablish the session without 
closing PowerTerm WBT. 
User-Initiated Fast Exit, for example by pressing <Alt> + <X>, while communication is in 
progress. In this case, PowerTerm WBT reacts according to the On PowerTerm Exit parameters 
that you selected in the Preferences tab of the Terminal Setup dialog. 
 
To enable PowerTerm WBT session to close automatically: 

Select Terminal | Setup. The Terminal Setup dialog is displayed. 1 
2 
3 

1 
2 
3 

• 

Select the Preferences tab and select Auto Exit PowerTerm.  
Click OK. If you have modified terminal parameters during a session, a message 
displays, asking if you want to save the setup configuration before closing. 

 
To enable PowerTerm WBT session to automatically reconnect when 
you exit the current session: 

Select Terminal | Setup. The Terminal Setup dialog is displayed. 
Select the Preferences tab and select Auto Reconnect.  
Click OK. 

 
At session termination the following message will be displayed: 

“Session closed (<exit code>). Hit Enter to restart session.” 
 
where <exit code> may be zero (0), i.e. communication ended successfully, or any number (other 
than 0), i.e. communication aborted. The exit code points to the error that caused the problem. 
 

Press Enter to re-establish communication based on the current terminal and communication 
parameters. 
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Step 7: Exiting PowerTerm WBT  

To exit PowerTerm WBT: 

Select File | Exit (Alt+F4) or click on the Exit button in the top right-hand corner. • 

N
 

OTE If you have changed the terminal settings, PowerTerm WBT displays a 
notification asking if you want to update the terminal settings. The 
message will point to the name of the setup configuration currently loaded. 

Click OK to update the setup configuration, or No to cancel the latest 
changes and restore the default setup. 
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Session Manager 

Chapter 

PowerTerm WBT Standard edition features a Session Manager that provides quick access to a 
list of user-configured sessions. The list includes both active and non-active sessions and you can 
in an easy way determine which of the non-activate sessions you want to activate. The Session 
Manager enables you to conveniently modify the connection parameters or setup of a desired 
connection. 
 
Activated sessions are also represented by lettered icons on the toolbar. Clicking on it will bring 
the active session to the foreground.  
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To activate all or some of the sessions: 

Select File | New Terminal Window, or click . The PowerTerm Session 
Manager dialog appears. 

1 

Select the desired session(s) to activate and click Activate Sessions. The selected 
emulation session is displayed.  

2 

1 
2 

 
To modify the connection parameters or setup of a desired 
connection: 

Select the desired connection. 

N
Right-c

OTE When modifying connection parameters, the Connection Name 
cannot be modified. 

lick the appropriate action. 
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Scripts 

Chapter 

 

PowerTerm WBT enables you to create scripts for automating tasks. For example, you can create 
a script to login to a PowerTerm WBT session, execute a file, display a message, etc. Scripts can 
be run upon startup or during a PowerTerm WBT session. They can be written in any standard 
text editor, like Notepad and are saved with a .PSL extension. This chapter describes how to 
create, edit, run, save and activate scripts in PowerTerm WBT. 
 
The Power Script Language (PSL) is PowerTerm’s own programming language. For a full 
description of the different PSL commands, see the “PowerTerm Power Script Language, 
Programmer’s Reference”. You can find exclusive PowerTerm WBT PSL commands in the 
Appendix at the end of this manual. 
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Using PowerTerm Scripts 

PowerTerm WBT provides the following script options: 
 
Create a Script

Edit a Script
Record a Script

specific scripts individual commands upon startup connecting to a host

Activate a recorded Script
Save a recorded Script, saves your scripts to be used at a later date. 

, creates a script to run upon startup or at any time during a PowerTerm WBT 
session. 

, edits an existing script file. 
, creates a script by recording all the actions that you perform in the PowerTerm 

WBT window. Actions can include selecting a menu option, typing an entry on the screen, 
making selections in a dialog, and so on. 
Run Scripts, runs  or , , , or 
during a PowerTerm WBT session, to automate specific tasks. You can only run saved scripts. 

, executes a non-saved script from the current memory. 

Assign Scripts, to the Power Pad and Soft buttons. 
 
To create a script file: 

Select Script | Edit Script. The Edit Script dialog appears. 1 
2 
3 
4 

5 

1 
2 
3 
4 
5 

1 

Type a name for the new script in the Script Name text box. 
Click Edit. The PowerTerm WBT Script Editor appears. 
Type the script and click Save from the File menu to save your new script. The next time 
you run or edit a script, this new file will appear in the Scripts List. 
Select File | Exit to exit the PowerTerm WBT Script Editor. 

 
To edit a script file: 

Select Script | Edit Script. The Edit Script dialog appears. 
Select the required script file in the files list.  
Click OK. The PowerTerm WBT Script Editor appears. 
Edit the script and click Save from the File menu to save your changes. 
Select File | Exit to exit the PowerTerm WBT Script Editor. 

 
To record a script: 

Click  or select Script | Start Script Recording. The Start Script Recording 
option changes to Stop Script Recording. 
Perform the manual operations that you want to record. For example, select a menu 
option, enter parameters in a dialog, or type a password. 

2 

3 

4 

5 

Select Script | Pause Script Recording if you do not want to record certain operations. 
The script recording process pauses and the menu option changes to Continue Script 
Recording. 
Select Script | Continue Script Recording to resume script recording. 

Select Script | Stop Script Recording or click  when you have performed all the 
operations to be stored in the script. 
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You can also save the script file that you created, so that you can run it at any time to 
repeat the operations.  
 

To run a specific script: 

Select Script | Run Script. The Run Script dialog, which lists all the scripts in the 
registry, appears: 

  

1 

Double-click the script that you want to run. The selected script is executed. 2 

1 
2 

3 

 
To run a script at startup: 

Standard 
Open the Connection Manager and select the appropriate connection. 

N
Click E

OTE In some PowerTerm WBT editions, you might have to select the 
Configure tab to be able to access the Edit button. 

dit. The Connection Properties dialog appears. 

 

Click .adjacent to the Script Name field. The Open Script dialog appears. 
Select the desired script from the Script List and click OK. The selected name appears in 
the Script Name field. You can also type the script name without browsing if you 
already know it. 

4 

5 

1 
2 
3 
4 
5 

Click OK. The designated script will be activated upon startup of this PowerTerm WBT 
session. 

Desktop  
Select File | Save As Icon. The Save As Icon dialog appears. 
Click OK. 
Select the icon on your desktop. 
Right-click Properties. The Shortcut to ptw32.exe Properties window is displayed. 
In the Target area, position your cursor after the .EXE file name, add a space and then 
type the name of the required script (.PSL) file.  

 
You can also add parameters to the script file. These determine communication parameters, for 
example the name of the host to which you want to connect, or the Port number.  
In the Target area, position your cursor after the PSL script name, add a space and type the 
required parameters. Parameters should be separated by a space.  
Example: 

\PTW32\PTW32.EXE COMM.PSL 1 9600 xonxoff 
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To run a script file during a PowerTerm WBT session using Soft 
buttons: 

Click the Soft button that has the desired script assigned. The script is executed. For more 
information, see Chapter 3, Step 2 Programming Soft Buttons. 

• 

 
To run a script file during a PowerTerm WBT session using the Power 
Pad: 

Click the Power Pad button that has the desired script assigned. The script is executed. For 
more information, see Chapter 3, Step 2 Programming the Power Pad. 

• 

 
To run a script file upon connecting to a host: 

Select Script | Run Script. The Open Script Setup dialog appears. 1 
2 
3 

1 
2 
3 

1 

Select the desired file. 
Click OK. The designated script is executed upon connection. 

 
To run individual script commands: 

Select Script | Script Command. The Script Command dialog appears. 
Type the name of the script command you want to run. Include parameters, if necessary. 
Click OK. The specified script command is executed. 

 
To activate a recorded script: 

• Select Script | Activate Recorded Script (<Alt> + <F9>). The 
script currently recorded in memory is now activated. 

 
To save a recorded script: 

Select Script | Save Recorded Script. The Save Recorded Script dialog appears: 

 
Enter a script name. 2 

3 Click OK. The script will be saved with the specified name.  
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Chapter 

Menu Reference 

This chapter describes each of the PowerTerm WBT Menu bar options. Use it for reference only. 
For a detailed explanation of each step involved, see Chapter 3: “Using PowerTerm WBT”. 
 
The PowerTerm WBT menus are: 
 
File Menu 
Edit Menu 
Terminal Menu 
Sessions Menu 
Options Menu 
Script Menu 
Help Menu 
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File Menu 

The File menu provides options to create, save and restore a terminal setup file. You can also 
open keyboard settings and save them as well as open a new instance of the PowerTerm WBT 
window. 

Save Terminal Setup 

Saves the currently opened setup file. Both terminal setup and communication parameters are 
saved to the current setup. 

Save Terminal Setup As 

Opens the Save Terminal Setup As dialog, which enables you to save the current setup 
configuration under a name other than its current one. 

Open Keyboard File 

Opens the Open Keyboard Setup dialog, which enables you to open keyboard mapping settings 
that have been previously saved in the registry. 

Save Keyboard File 

Opens the Save Keyboard Setup dialog, which enables you to save separate keyboard mapping 
settings in the registry and open them at a later date. 

Open Power Pad File 

Opens the Open Power Pad Setup dialog box, which enables you to open Power Pad settings 
that have previously been saved in the registry. 

Save Power Pad File 

Opens the Save Power Pad Setup dialog, which enables you to save Power Pad settings in the 
registry and open them at a later date. 

Print Screen 

Prints the contents of the work area. 

 Print Setup  

Displays the Print dialog, which contains modifiable printing parameters.  
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Start/Stop Auto Print 

Prints all the data displayed in the work area. This option changes to Stop Printing once the 
Start Auto Print function is activated. Select Stop Printing to stop printing the data displayed in 
the work area. 

Close Print Queue 

Manually closes the print queue. 

Form Feed 

Executes a form feed on the printer. 

Line Feed 

Executes a line feed on the printer. 

New Terminal Window 

Opens the Session Manager, which enables activating a pre-defined terminal session. 

Exit All Sessions 

Enables you to exit from all PowerTerm WBT sessions. 

Exit 

Enables you to exit from the current PowerTerm WBT session. 
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Edit Menu 

The Edit menu provides options to select, clear, and reverse text in the PowerTerm WBT window 
and delete the contents of the history buffer. The Edit menu also provides standard Windows 
editing commands (cut/copy/paste), in addition to commands that enable you to copy data to a file 
and copy data automatically to the clipboard. 

Select Screen 

Selects the contents of the entire work area. 

Clear Screen 

Captures the entire PowerTerm WBT screen and passes the data to the history buffer. An example 
of an application that issues clear screen commands is VMS Mail. 

Clear History 

Deletes the entire contents of the history or scroll back buffer. This command is only available 
when the history buffer is in use. 

Reverse Screen  

Reverses the screen. You can type from left to right or right to left, depending on the language 
you are using. 

Copy 

If the Automatic Copy option in the Edit menu is not active, use the Edit/Copy command to 
copy the marked text to the clipboard. 

Paste 

Pastes the clipboard contents into the work area.  
Right-click (or select Edit/Paste) to send the host data stored in the clipboard. This operation is 
equivalent to actually typing the contents of the clipboard on the host screen. 

Copy Table 

Copies a table to a spreadsheet while maintaining the contents of each of its individual cells.  

Automatic Copy 

Selected text from the work area is automatically copied to the clipboard. 
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Copy Right To Left  

Reverses the order of the letters in the word that was copied to the clipboard when displayed. 
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Terminal Menu 

The Terminal menu provides options to define and reset connection parameters, as well as to set 
the system to be online or offline.  

Setup 

Opens the Terminal Setup dialog in which you can define settings for terminal emulation. This 
dialog contains different tab pages that enable you to define all aspects of your terminal setup. 

PowerTerm Fonts 

Displays the PowerTerm fonts in the PowerTerm WBT window. 

System Fonts 

Provides a selection of system fonts from which to choose. 

Reset 

Resets the VT terminal defaults. This command does not apply to PowerTerm WBT’s exclusive 
terminal parameters (such as color). 

Online 

Sets the system to be online or offline. 

Hold Screen 

Stops communication and freezes the screen. To unfreeze the screen, reselect the command. 

English 

Alternatively, the language can be configured so that the user interface appears in German, 
French, Italian, Spanish or Greek. 
 

   
 



 
  

73

Sessions Menu 

The Session menu lists all the active PowerTerm WBT sessions and enables you to toggle 
between them. The first session generated is automatically named Session A, the next Session B, 
and so on. 
 
Alternatively, you can click the desired session icon on the Session toolbar. 
 

   
 



 
  

74

Options Menu 

The Options menu enables you to show or hide PowerTerm WBT window components. The 
Options menu also enables you to display and edit the keyboard and Power Pad mapping and 
define the Power Pad display.  

Keyboard Map 

Displays the Keyboard Mapping dialog, which enables you to map your PC keys to host keys on 
the terminal keyboard.  

Power Pad Setup 

Displays the Power Pad Setup dialog, which enables you to adjust the number of buttons 
contained in the Power Pad by specifying the number of rows and columns to be displayed.  

Start/Stop Trace 
 
Stores received data in the Trace.log and Capture.log files. These files are located in the working 
directory. Capture.log stores raw data, as received from the host. Trace.log stores formatted data 
with readable escape sequences. 
After activating Start Trace, the menu command changes to Stop Trace. Click it to stop storing 
the data. 

Input Trace 
Inputs the contents of the Capture.log file to PowerTerm, as if it were received from the host. 

Hide Menu 
Hides the Menu bar.  

Hide Buttons 
Hides the Soft buttons. 
The menu option becomes Show Buttons.  

Hide Status Bar 
Hides the Status Bar. 
The menu option becomes Status Bar. 
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Hide Power Pad 
Hides the Status Bar.  
The menu option becomes Show Power Pad.  

N
 

OTE  Press <Ctrl> + <Shift> + M to display a floating menu which offers to 
show/hide menu, buttons, status bar, and Power Pad. 
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Script Menu 

The Script menu provides options to record, edit, and run a script. 

Run Script 

Displays the Run Script dialog, which enables you to select and run a script. 

Edit Script 

Displays the Edit Script dialog, which enables you to select the script that you want to edit or to 
create a new one. The selected script is opened for editing in PowerTerm WBT Editor. 

Script Command 

Displays the Script Command dialog, which enables you to run individual script commands. 

Start /Stop Script Recording 

Records a script automatically. After requesting Start Script Recording, the manual operations 
you perform in the emulation screen are recorded into a script file until you choose the Pause or 
Stop Script Recording command. 

Pause/Continue Script Recording 

Pauses or resumes the script recording. 

Activate Recorded Script 

Activates the script currently recorded in memory. The script is saved in memory while 
PowerTerm WBT session is active until it is saved to the registry with a specific name. 

Save Recorded Script 

Enables you to save a script from memory to the registry with a specific name.  
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Help Menu 

The Help menu provides options for accessing the product information. 

About PowerTerm WBT 

Displays product and contact information.  

   
 



 
   

   
 

78

 

Appendix

Exclusive PowerTerm WBT PSL 
Command 

Activate Connection 
Opens a session according to communication parameters previously defined in the PT WBT 
Connection properties dialog in the Connection Manager. 

Syntax 
Activate-Connection connection-name 
 
connection-name Specifies the name of the desired host connection. 

Returns 
An empty string. 

Example 1 
Opens a COM session with the following parameters: 

set comm-type com 
set port-number 2 
set baud-rate 19200 
set protocol-type xonxoff 
Activate-Connection 

Example 2 
Modifies the COM session to 9600 baud-rate: 

set baud-rate 9600 
Activate-Connection 

Example 3 
Opens the setup file "abc.pts" for working with specific PowerTerm parameters for the "abc" host 
(similar to the Open command on the File menu). Then opens a Telnet session to host "abc" 
(similar to the Connect command on the Communication menu). 
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open-setup-file abc.pts 
set comm-type telnet 
set host-name abc 
Activate-Connection 

Example 4 
Opens a lat session to host "abc" through DIGITAL PATHWORKS 32: 

set comm-type lat 
set service-name abc 
Activate-Connection 

Example 5 
Opens a session to host "abc" through Novell's NetWare for LAT: 

set comm-type lat 
set server-name NovellServerName 
set service-name abc 
Activate-Connection 
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Appendix

Creating Captures and Log Files 

Ericom Software’s Technical Support is happy to assist you anytime. To facilitate and assist in 
troubleshooting, it is recommended that you send captures and log files to the Technical Support. 
You can create the captures and log files automatically in the emulation screen. 
 
To create captures and log files with the tracing option: 

Select Options | Start Trace. 
Arrive at the trouble spot.  
Select Options | Stop Trace. The Send Captures to Ericom Support mail dialog 
appears with capture, tcpip and trace logs attached. 

 
To create captures and log files with key combinations: 

Connect to the desired connection in Connection Manager.  
Perform the following key combinations: 
Press key combination Appears on the Status bar as  
ctrl+shift+s (mandatory) “capture.log with send” 
ctrl+shift+k “capture.log with send with keys” 

Warning: One’s password is liable to 
be recorded in this manner. 

ctrl+shift+t “tcpip.log” 
3 
4 

Arrive at the trouble spot. 
Continue with the following key combinations: 
Press key combination Appears on the Status bar as  
ctrl+shift+s (mandatory) “capture file end” 
ctrl+shift+t “tcpip.log end” 
ctrl+shift+v View the log file before it is sent. 

5 The following files are compressed into a CAB file, which is automatically attached to an 
email addressed to Technical Support: 
capture.log 
tcpip.log 
Context.txt 
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TermScr.bmp 
setup files:  ptdef.*, ptcomm.ini 
Click Send. The CAB file is sent to Ericom Software’s Technical Support. 6 
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